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Chapter 2
GUIDED TOUR

Readirisis a state-of-the-art OCR package equipped with numerous advanced
features. We will discuss all major featuresin this chapter and add many tips and
hints concerning the use of Readiris.

STARTING THE SOFTWARE UP

Click on the Readiris application in the submenu "I.R.1.S. Applications -
Readiris', or click on the shortcut to the Readiris application on your desktop.
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The Readiris startup screen and application window are displayed. The startup
screen displays the version and copyrights of the Readiris software. Clicking the
mouse anywhere makes this screen disappear.
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The next window concerns the OCR wizard; click Cancel for the time being.

THE FIRST-TIME STARTUP

Depending on the software bundle you acquired, the first startup may be spe-
cia: you may be prompted to register your licence.
If thisisthe case, the use of Readirisislimited to 30 days, and by registering,

you receive afree softkey from I.R.I.S. to continue using the software after the
first month.

It takes your identification number to generate the softkey; be sure that this
number is available or mentioned when you register your licence.
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Readins |

The identification number on thiz machine iz

1654 AE36ECE 314 4E363ICE 3ICT414BE Help |

To enable thiz zofbware, you need a key.
Pleaze contact |.F.1.5. to obtain this key

Enter your key number:

[
] I | don't hawve this key

DiscoVvERING THE READIRIS INTERFACE

The Readiris application window not only contains command menus but
also two button bars that give quick access to al frequent commands. Initialy,
some command menus are dimmed: they concern the preview. As long as ho
image is opened, they are unavailable.
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The same goes for the image toolbar on the right side of the application
window: it contains all commands you need during the image preview. The main
toolbar on the left gives quick access to all frequent general commands.

To learn which command corresponds to a certain button, hold your mouse
pointer over it for awhile: atooltip will tell what the button does.
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File Edit Seftng: “iew Process

Perform automatic recognition
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Finaly, the window pane or image zone is where the scanned images are
displayed. You can drop image files onto the image zone to recognize them.

GETTING STARTED WITH A FIRST TUTORIAL

The best way to become familiar with the operation of Readiris is undoubt-
edly by using it. A humber of prescanned images is provided with the software;
they dlow you to get started even when there is no scanner connected to your
computer. Let's turn to these now.

The "Source" button on the main toolbar determines whether you are going
to use a scanner or a prescanned image as image source. Readiris allows you to
open TIFF images (uncompressed, packbits, Group 3 and Group 4 compressed),
Paintbrush (PCX) images and Windows bitmaps (BMP). Only black-and-white
images are supported. This capability is particularly useful to convert your faxes
into editable text files.

Asyou are going to open a prescanned image, you should select the disk, and
not the scanner, as image source with the "Source" button.

= ol

Source Source

Next, click the "Open" button. (When you select the disk asimage source, the
"Scan" button is replaced by the "Open" button and the corresponding " Scan"
command under the "Process' menu is replaced by the "Open" command.)

=0 =

Scan Open

You could also select the command "Open" from the "File" menu and open a
prescanned image directly - this works even if your scanner operates as current

image source.
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You are invited to select an image file. Select the file ENGLISH.TIF in the

Readiris folder. The image is read from disk and displayed in the image zone
progressively.
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A third way of opening prescanned images is the use of “drag and drop”:
drag an image from the Windows Explorer onto the Readirisimage zoneand it is
opened promptly.

The image toolbar on the right side of the Readiris application window con-

tains al commands you need during the image preview: tools to indicate the
zones of interest, to rotate the image, zoom in and out etc.
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ZOOMING IN ON IMAGES

Readiris has severa commands that allow you to zoom in on the scanned
image, for instance to verify the scanning qudity.

The image toolbar contains buttons that allow you to zoom in at real size, to
fit the image to the page width and to fit the entire image in the preview window.
The "View" menu contains the same commands and adds two extra zoom levels:
you can display the image at 50% and 200% of its actual size. At actua size, a
screen pixel corresponds to an image pixd. (Shortcuts are available for al zoom
levelsl)

v Fit b Window Ctel+F
Fit o width Chrl+w

[ B0% Actual Size  Chies

ﬁ Actual Size Ctrl+1

| = 200% Actual Size Chl+2

Finaly, you can right-click the mouse button over a region of the scanned
image to zoom in at rea sizeimmediately. Right-click a second time to zoom out

again.
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ONE, DECOMPOSING A SCANNED IMAGE

Now that the image is scanned, you have to indicate which parts you want to
convert into editable text by drawing frames, so-caled “windows’, around the
zones of interest.

Actually, Readiris will do this for you automatically when the option "Page
Analysis' is enabled on the main toolbar.

alll, Hi}

Page Analysis Page Analysis
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Automatic page decomposition is particularly useful when columnized texts
and documents with a complex page layout, possibly including graphics and
tables, are recognized.
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Page decomposition uses three window types: text, graphic and table win-
dows. Readiris discriminates text blocks, tables and graphic zones containing
photos, illustrations etc. on the page. (Saving graphics and recognizing tables
will be discussed at great length below.)

A color code indicates the window type: text zones are yellow, graphics are
blue and tables are purple.



&

The number of windows is indicated at al times in the tooltips of the "Text
Window", "Graphic Window" and "Table Window" tools.

—]
i 5
4 o]
Diraw text window: 3 Draw graphic window: 1
- T

=TT

Draw table window: 2

Page analyisis is fast, skew-tolerant and highly accurate: it traces complex,
“irregular” shapes.

DISPLAY: Sceptre’s
CD-1112T LCD panel

The page analysiswill even detect zones where you get white text on a black
background. Recognizing such inserts is no problem: while the preview dis-
plays the scanned document correctly on-screen, Readiris “inverts’ the image
when the need arises to recognize such text blocks! (You can have your scanner
generate fully inverted images to process pages with white text on a black back-
ground. See below.)

ONE AND A HALF, SorTING WINDOWS

Readiris not only detects the various blocks, but also sorts them: the zones
are sorted top-down, left to right by default to cope with columnized documents.

Evidently, you can modify thesort order. To do so, click the" Sort" button on
the main toolbar. The mouse cursor becomes a pointing hand as soon as the “ sort
mode” is enabled.

-

Sort

Click on the windows you want to include. Windows you do not click on are
simply ignored, excluded from recognition. It's easy to see which windows are
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selected and which aren't; the sdlected windows have their full color, non-se-
lected windows have a lighter color tone.
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Page analysis is enabled by default. To force Readiris to decompose the cur-
rent page - because you disabled page analysis by accident, because you erased
some windows erroneoudly and want to redo the page andysis etc. -, you can
simply click the button "Anayze Page" in the image toolbar.

#8

(Select the document language before executing the page analysis when you
are deding with Asian documents. Specific routines are used for these languages:
the interline spacing of Asian documentsisin most cases bigger than in Western
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documents, the text is made up of small icons (“ideograms’) that could easily be
seen as graphic zones in Western documents and the text may run from top to
bottom, from right to left.)

Two, WINDOWING A SCANNED IMAGE MANUALLY

Page analysis is the automatic way of windowing a scanned page. Alterna-
tively, you can zone an image manually with the windowing tools of Readiris.

Select window

Drraw text window: 0

*‘ |Draw graphic window: D|

B | [Draw table window: 0]

To create arectangle around a zone of interest, select the corresponding tool
in the image toolbar, click the cursor in the upper left corner of the window,
stretch the window by moving the mouse to the lower right corner and click
again. (Sides smaler than 1 mm are not alowed, they wouldn't even contain a
single character anyway.)

The windows are automatically sorted in the order of creation: arrows indi-
cate the sort order.

You can also frame “irregular” text blocks by drawing polygonal windows
around them. Non-rectangular windows are created by merging rectangular zones:
as soon as two rectangles (of the same type) intersect, they become a single
window automatically! In a way, you're building a house by adding one room
after the other... (Creating polygond table windows doesn't make any sense.)
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Furthermore, manual windowing can be combined with window sorting: you
can draw new windows even when the “sort mode’ is enabled. You then use
sorting to include a number of detected windows and manually create some other
windows where the page analysis didn't yield the appropriate results. As soon as
you dtart creating windows in the “sort mode’, al windows you didn't select are
promptly erased!

To modify, move and delete windows, you need to select them first. To do so,
select the "Window Selection” or “arrow” tool in the image toolbar and click
inside a window. Rectangular markers now appear at each corner and in the
middle of the window sides.

~x | |A word about OCR
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Tounselect windows, click the mouse button elsewhere. To select additional
windows, hold down the Shift key while clicking on these extra windows. To
select a window and the included windows (of another type), hold down the
Ctrl key while clicking on the main window.

You can display the type, pixel coordinates and sort order of a window by
pressing the Alt key while you select it!
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So much for sdecting windows. To modify a window, sdect it, put your
mouse cursor over a marker and drag the side to change the window size.

To move awindow, simply select it and drag it to another location.

To delete windows, select the window(s) and choose the "Cut" or "Clear"
command from the "Edit" menu. The "Cut" command cuts the window(s) to an
interna buffer, "Clear" erases the window(s) irretrievably. When you paste win-
dows, they are inserted in their origina position, and you have to drag them to
their new location.

In fact, all familiar commands from the "Edit" menu apply to the windows.
you can delete, cut, copy and paste them! The "Undo" command aso applies: if
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you have unfortunately deleted, moved, resized etc. some windows, "Undo" will
cancel the last operation.

Undo  Al+BkSp
Cut Chrl+2
Copy Cirl+C
Paste Chrl+y
Clear Delete
Select Al Chrl+d,

Also note that shortcuts are available for all commands! Let's give an ex-
ample: to erase al existing windows, you can choose the command "Select All"
or its shortcut Ctrl+A and click the command "Clear” or its shortcut Delete. You
are now ready to recreate the necessary layout. To restore the previous layout,
you can choose "Undo" or the shortcut Alt+Backspace.

THREE, SAVING WINDOWING TEMPLATES

The resulting windowing layouts can be saved as zoning templates for fu-
ture use with the command " Save Layout” under the "File" menu and loaded into
memory with the command "Load Layout".

Save Lapout... [!

If you have to recognize documents with a similar layout, for instance a 50
page report where the header and footer should be excluded for obvious reasons,
a single template can be applied to zone al 50 pages.

When you load a template into memory, page analysis is disabled automati-
caly. The zoning template remains active until you re-enable page analysis on
the main toolbar.
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ReADIRIS TAKES You AROUND THE WORLD

Assuming that the windows are correctly defined, you are now amost ready
to execute the character recognition. We say “amost”, because we haven't veri-
fied the language and document settings yet.

The language setting can be found on the main toolbar.

Englizh

Click the "Language" button to modify the document language.

Langusge |

English =] oK

Croatian -

Czech

Danizh Cancel
Diutch I
E ztonian

= Finnigh

French

Frizian

German 5

You can press a letter key to move to it directly: if English is currently se-
lected, and you want to select Hungarian, you can click the "H" key on your
keyboard to go directly to the Hungarian language. When several languages have
the same initia, press the letter several times to go through the options. Let's
give an example: Readiris reads Polish and Portuguese. By pressing "P" once,
you select Polish, by pressing "P" a second time, you select Portuguese, and by
pressing "P"' athird time, you're back on Polish. (To go to another letter, say T,
press BackSpace before you enter the "T" character.)
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Readirisisfar from limited to English: up to 55 languages are supported! All
American and European languages are supported, including the Central-Euro-
pean languages, Greek, Turkish, the Cyrillic (“Russian”) and the Baltic languages.

Optiondly, you can read Asian documents: the extra module “Asian OCR
add-on” offers recognition of Japanese and Simplified Chinese. Traditional Chi-
nese is not supported. (Simplified Chinese is used on China's mainland, where
Traditiona Chinese is used by the “Big 5" communities - Hong Kong, Taiwan,
Singapore €etc.)

Also note that the British and American - or should we say “international” ? -
variants of the English language are distinguished.

It takes the appropriate Windows configuration to display Central-European,
Greek, Turkish, Cyrillic and Baltic characters. You may have to install the Win-
dows “service pack” "Multilanguage Support" before your Windows system is
able to cope with these languages. Select the icon "Add/Remove Programs' un-
der the "Control Panel" to find out if this Windows module is ingtalled on your
PC. Depending on the software bundle you acquired, the Readiris CD-ROM
may contain detailled information on how to ingtal this Windows module.
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To view and edit Asian documents, you can install an Asian, Japanese or
Chinese version of the Windows operating system or run specialized “emulat-
ing” software (such as UnionWay AsianSuite or TwinBridge AsianBridge) on a
Western version of Windows to correctly represent the ideograms of these Asian
languages.

Selecting the proper document language is imperative. Based on the selection
of alanguage, the software knows which symbol set to recognize. Multi-linguis-
tic support ensures that “exotic” characters such as ¢, 3, fi, g and @ are recog-
nized correctly.
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Secondly, the software extensively uses linguistic databases to validate its
results. Suppose that you have to read the word "president” where an ink stain
makesthe "r" look like an "f". Looking things up in the English lexicon, Readiris
will detect autonomoudly that theword "president” is being read and that it doesn't
make any sense to recognize the symbol "f". This “self-learning” technique is
of course highly dependant on the linguistic context.

Linguistics offer useful help to solve ambiguous cases such asan "O" which
might be mistaken for a'0". Another typical exampleisthe letter "I" and number
'1' which have an identical form in many fonts - think of texts produced on old
typewriters! The linguistic context helps to determine whether you are dealing
with "1" or '1".

The illustration below shows various shapes of '1" and "I". The shapes on the
firgt line are unambiguous, the shapes on the second line are ambiguous, but
linguigtics can solve them. When the context does not suffice, the user inter-

193 1950s. hr
Well, Rossellini

REeADIRIS CHANGES LANGUAGES As NEEDED

But the buck doesn't stop here: Readiris can switch languages in the middle
of a sentence without any help from the user! When Western words pop up in
Greek, Cyrillic or Asian documents - many untranscrible proper names, brand
names etc. are written using the familiar Western symbols -, Readiris can switch
to the correct aphabet automaticaly. In other words, you can activate a mixed
alphabet of Greek, Cyrillic or Asian and Western characters.

Be sure to select "Greek-English” or the appropriate Cyrillic language setting
- for instance "Byeorussian-English”. In other words. don't try to just select
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"Greek" or "Byelorussian” as document language and hope that the Western sym-

bolswill come out finel

Russian-E Greek-E

Here's an example where a Russian text contains some English words - open
the image file ALPHABET.TIF if you want to try it for yourself!

4 Readinis - D:\Readiris\alphabet.tif
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Russian - English

IIpennasznavennemM cHecTeMBl (JTITHYECKOrO
PacnosnapaHmBs 3HaKoB ABIACTCA
ABTOMATHUCCKHHA BBOJT TMMETATHRIX
JOKYMEHTOB B IAMSATHL KOMIIBIOTCpa Kpaine
2ddexkTHBIEIM @ H  ASINEBRHM  IIYTEM,
HecMmorps ma TO, ¥ro paszpaboTka I3TOH
cucremb (OCR) OLUIa nIpeOnpHASTA emg
20 ner Hazan, Ira TEXHOJNOrHA €Ifeé MmokKa
HEH3BECTHA INKPOKOH ny0nmke  ona
ABTOMATHYCCKOIO BBOJg Mairepuana H
}'[OKW&HTOB.

<] |

e

The end result looks like this when opened with the wordprocessor - you may

have to sdlect a Cyrillic font to display the Russian text correctly.
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IIpenHazHade HHEM CHCTEME OIMTHYECKOTO
Pacnosnapanua SHaxos ABnAeTCA

ABTOMATHYECKHA BECT [E9aTHHE
OOKYMEHTOE B IAMATE KoMIBIOTEpa Kpafine
st PEXTHEHEIM H TEIIEBEIM IYTEM.
HecumotpgeTa s, 9To paspaboTka 3TolR
CHCTBMI:IJ‘IB. OpERNPHHATA EIE
20 mer Hazaz, 5Ta TEXHOMOTHA EIE MoKa
HEHIEECTHA WHpoKeH OybnuKe gua

ABETOMATHHUECKOTS EBOJOA MATEDHANA H
DOEVMEHTOE.

Faor Help, press F1 NUM 2

To mix other languages, smply sdlect the language with the most extended
character set. If you have adocument where the, say, French trandation is placed
alongside an English text, you have to select French as language to ensure that
the accentuated characters such as ¢, € and U get recognized correctly.

DerINING THE DocUMENT CHARACTERISTICS

Now that the language is set, we'll turn to the other document characteristics.
You can fine-tune the recognition by specifying some document features: the
font type and character pitch. (These commands do not apply to Asian docu-
ments.) Let’s clarify what this means.

First of al, indicate whether you are recognizing “norma” or dot matrix
printed documents with the command "Font Type" under the "Settings' menu.
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Setting this parameter correctly is mandatory: “draft” or “9 pin” dot matrix
symbols are made up of isolated, separate dots, and highly specialized recogni-
tion routines are required to recognize them.

ape—~descended 1i1fe

“Letter quality” dot matrix printing, also called “25 pin” or “NLQ” dot ma-
trix, requires the normal setting, as do the printing qualities typeset, typewrit-
ten, laser printed and inkjet printed. Obvioudly, "Normal" is the default value.

The font type is indicated in the tooltip of the "Recognize" button: when no
message is added to the tooltip, the “normal” printing quality applies, when the
message "Dot Matrix" shows up in the toaltip, the dot matrix reading mode is

enabled.
Recognize

s, |Perform text recognition: Dot matrix

The character pitch can be set with the command "Character Pitch" under
the "Settings' menu.

LCharacter Pitch r

Firned
Proportional

With fixed or “monospaced” fonts, all symbols of the font have the same
width. An "i" takes up as much horizontal space on a line
as a "w', as is the case in this sentence. Think of
documents produced using a typewriter, where the carriage moves a fixed dis-
tance for each typed symboal.

A proportional pitch meansthat the width of acharacter depends on its shape.
Symbols like m and w are wider, take more horizontal space on a line than the
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thin characters 1 or j . Virtualy al books, magazines and newspapers are
printed in proportional pitch.

Courier, a fixed or “monospaced” font
Letter Gothic, a fixed or “monospaced” font

Century Schoolbook, a proportional font
Arial, a proportional font

The simplest solution is to leave this option at al times on the default value
"Auto", which means that Readiris will detect the character pitch automatically.

ReADIRIS GETS MORE INTELLIGENT EAcCH TiME!

When the document language is selected and document characteristics are
set, you can click the "Recognize" button.

i
[ale )

Recognize

The OCR progressisindicated on-screen. You can click the "Stop" button to
abort the text recognition.

QCR in progress. .




&

At the end of the recognition, Readiris enters the interactive learning phase
when the learning is enabled with the "Learn" button on the main toolbar. Inter-
active learning is enabled by defaullt.

(Interactive learning does not apply to Asian documents. learning does not
make sense for these languages which use thousands of different symbols - and
you'd have to be able to enter the ideograms, not an easy task when using a
Western keyboard!)

¢° B A
Leatn Learn

Font training can substantially enhance the accuracy of the recognition sys-
tem. When the user tries to read distorted, defaced forms as are found in real
documents or stylized font shapes which Readiris does not recognize optimally,
training can overcome this temporary “failure”’.

User learning is also used to train the system on special symbols which
Readirisis unable to recognize, such as mathematical and scientific symbols and
dingbats. Some examples. Readiris can be trained to recognize the "p" symbol
as "pi" or the dingbat "&" as "Td". (However, the list of recognized symbols
cannot be extended with the symbols "p"and "@"!)

Therecognized text isdisplayed progressively and the system stops on doubtful
characters, or - if you are dealing with touching characters (“ligatures’) - on
doubtful character strings. They are dways presented in their context, the doubt-
ful characters are highlighted. Unrecognized characters are represented by atilde
(the "~" symbol).
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Mew Dictionary: D:\Readiris\Headiriz.dus

took up a collection. They gathered enough money - and Jewel
won a partial scholarship - to send her off. In Michigan, Jewel Learn
learned to play guitar. "Because of my history'' - she's

dyslexic - "it's hard for me to Don't Learn

Delete

Undo

learn
m

Abort

]

First thing you should do is verify if you activated the correct font dictionary
and dictionary mode - these are always indicated in the title of the learning win-
dow. If that is not the case, click the "Abort" button - the document image is
redisplayed with the zoning as was created - enable the right font dictionary or
dictionary mode and run the OCR again. (The operation of font dictionaries will
be discussed shortly.)

If necessary, enter a character (or character string) for the incorrect or un-
known shape and click one of the following buttons.

Learn

You agree with the proposed solution or correct it. The program saves this
doubtful character in the font dictionary as “sure”, final. Future recognition will
no longer require your intervention, the shape is considered learnt once and for
all.

In the example above, the system stops on a soiled character, and we click
"Learn" to accept a shape which cannot be confused with other characters.
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Don't Learn

You agree with the proposed solution or correct it. The difference with the
"Learn" button is that the learnt symbol gets the status “unsure” in the dictio-
nary. For future recognition, the system will propose the learnt solution but still
require a confirmation.

This button is used for symbols which might be confused with others. a de-
faced "e" which might be mistaken for a "c", a damaged "t" which closdy re-
sembles an "r" etc.

Mew Dictionary: D:\Headiriz\Headiriz.dus

the boat and let the line drift with the current, jigging the rod tip
to jerk the bugs. ""We call it the Rogue River twitch," he said. Learn
George stood up, made several elegant false casts and began
twitching. | sat and twitched. Mullinnix pumped the oars with Don't Learn
strong. staccato strokes that made our heads jerk backward. _
Soon we were all twitching and pumping in silent sinchronicity.

A pelting downpour began. Through the rain, the Delete

Undo

Finish

]

Isl— Abort

The"s" aboveis serioudy damaged - in fact it iscloseto the"£" symbol -, and
you should click "Don't Learn" so as hot to confuse it with the pound symbol.

Delete

The displayed form is eliminated from the output. This button is used to ig-
nore “noise” on the documents - spots, coffee stains etc. - which might get recog-
nized as points, comma's and what have you -, and to erase any other unwanted
symbol.
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Undo

You go back to correct mistakes. You can undo the nine last decisions.

Finish
Thelearning processis aborted but the OCR continuesin automatic mode. All
decisions by the system thereafter are accepted without user validation.

Click this button when you see that the recognition is highly accurate and does
not require detailled proofreading.

Don't confuse"Finish" with the"Abort" button: with " Abort", no output isgen-
erated and you start all over, with "Finish", the text is created, it just isn't proof-
read in detail!

THE RoLE oF FoNT DICTIONARIES

The results of each training session are temporarily held in the computer’s
memory but can and should be stored in files called “dictionaries’ for future use.

These font dictionaries should be loaded into memory when you want to rec-
ognize similar documents in order to make use of the extra intelligence they
contain; in this way, Readiris takes into account the intelligence stored in these
font libraries. You could say that Readiris gets more intelligence each time you
use it!

How does this work? The operation of font dictionaries is controlled by the
"Learn" menu: you have to select a dictionary with the command "Font Dictio-
nary" and determine its mode of operation.



Dictionary
Look jn: Iaﬂeadiris j £F
Readiriz.dus

File narme: IHeadiris Open I
Files of bupe: IDiclionary =l Cancel |

& Mew Dictionary

€ Append Dictionarny
' Read Dictionary

Font dictionaries are limited to 500 shapes, and you are recommended to
create separate dictionaries for specific applications, for instance per type of
document. For clarity, you are recommended to give meaningful names to the
font dictionaries, for instance REPORT.DUS, PALATINO.DUS etc. Dictionar-
ies have the default extension *.DUS. Training no longer has effect when the
dictionary is full: the results of the learning are no longer held in memory or
written to a dictionary.

You can st the dictionary mode inside the command "Font Dictionary" or
directly under the "Learn” menu. Three dictionary modes are available: new,
append and read.
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Font Dictionarny... Chl+D

v Mew Font Dictionan
Append Fant Dictionan
Bead Font Dictionary

v |nteractive Learing

By sdlecting "New Font Dictionary”, you indicate that the training results will
be saved in anew dictionary. (If you select an existing dictionary, its contents will
be erased.)

The append mode indicates that the training results will be saved in an exist-
ing dictionary: the recognition makes use of the extra intelligence aready con-
tained in the dictionary, and you add new font shapes to it. In simple terms, this
option alows you to build up afont dictionary in several steps.

(When you enter a filename for a new dictionary and activate the “append”
mode, an empty font dictionary is created and you complete it.)

With thelast option, "Read Font Dictionary", the dictionary functionsin read-
only mode: you make use of the dictionary without adding new font shapes to it.

Select the new mode when a single page is recognized. To recognize many
pages of the same type - pages with the same fonts and printing quality - select
the new mode for the first page, the append mode for a few pages more and the
read mode for the rest of the document(s). When multipage documents are rec-
oghized, scanning a next page automatically puts the user dictionary in the ap-
pend mode.

Know that the tooltip of the "Learn" button indicates at al times which font
dictionary is currently active and in which mode that dictionary operates.
&?

Interactive learning: D:\Readinis’\Feadinis. dus [New Dictionary]|

Learn
4]
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When you enter the interactive learning, the dictionary and its operating mode
are indicated in the window title; you should click the "Abort" button and start
over in case they are wrong.

Mew Dictionary: D:\Readiriz\Headiriz. dus

Almost immediately we encountered Graves Creek Falls, a |

O-foot drop through a boulder field. Rowing bow first. Mullinnix
heaved against the oars to slow our progress and then, at the
lip of the drop. swung sideways to pick his slot. At the last Don't Learn |
second, he pivoted downstream, and we shot through the froth _
without so0 much as kissing a rock. "Deftly done:' | said as an
icebreaker. "What class was that [IEEE Delete |
:J i _ e |
n e Einish |
L
F __ o |

SENDING THE RESULT DIRECTLY TO YOUR APPLICATION

The interactive training concludes the character recognition. As Microsoft
Word 97 operates as output target by default, your wordprocessor is started up
automatically at the end of the recognition (if necessary) and the recognized text
is inserted.

The scanned image is displayed again with the zoning as created to be avail-
able for further processing, it stays there until you scan another page.

You have indeed converted a paper document into an editable computer file,
be it 10 to 25 times faster than manual retyping! Go ahead and compare it with
the image you have inside your Readiris window.

Actually, Readiris offers three different methods when it comes to saving the
OCR resault: sending the recognized document directly to a target application,
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saving the result in an externa file and copying the result to the Windows clip-
board.

The output target is selected using the "Format" button on the main toolbar
(or the command "Text Format" under the "Settings' menu).

Text Format E
— Dutput
{* Sendlo IMicrnsoft whord 97 j
" External file I.-’-‘«SEII [.kat] j
i~ Layout

" Create body text

" Betain word and paragraph formatting

' Recreate sounce document

— Optionz
¥ Merge lines into paragraphs

¥ Include qraphics

Canicel |

The "Send to" feature offers a direct OCR link between your scanner and
your Windows applications. you send the scanned documents directly to your
wordprocessor or spreadsheet! Readiris exports recognized documents directly
to Microsoft Word 97, to Microsoft Excel and the Windows accessory WordPad.



Dutput
% Sendto Microsoft Word 97 j
. b Jord 97 ;
" Extemal file Microzoft Excel
YWordPad
Layout Clipboard
™ Crasta hedu baut Clipbaard E nesl

At the end of the recognition, the target application is started up and the rec-
oghized document is opened inside a new text file or workshest.

Pleaze wait while loading ‘word...

Don't forget that the option "Send to" also alows you to copy the recognized
text to the Windows clipboard, so thereis no strict need to export the result... or
save it to an externa file!

SAVING THE REsSULTS IN A TEXT FILE

You can indeed write the OCR result to an “externa” file. Readiris supports
awiderange of fileformatsincorporating al popular wordprocessors and spread-
sheets - Microsoft Word (DOC), RTF and HTML etc.
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— Dutput
" Sendto | Micrasaft word 97 [
f* Ertemnal file Whord 97 [*.doc) j
ASCI = tat] e
— Layout AMS] [ bat) -

" Create body text
{~ Retain word and paragraph fd

= Recreate source document

Word 2% [ doc)
“Word 4.0, 6.0,
Mford 97
Excel [F.cav)
Excel [* htm]

HTML [*htm]

— Optionz
v Merge lines into paragraphs

™ Include graphics

Displayafrite [*.dw ]
tdultitd ate [*.mm ]
“WwhordStar [*ws )

DCA [*.dca)

Rich Text Format [* 1tf]

7.0.97 [

whordPerfect 4.2 [*.wp |
“WordPerfect 5, B, 8.x [%.1H)

WhordStar 2000 [*.ws2)

When you sdlect the option "External File",

you are prompted to save the

recognized text at the end of the recognition phase.



Output File

Save in: Ia My Documents

Filz narne: IUntitIed Save I
Save as hpe: I\A-"c-ld 4.0,68.0,7.0, 97 j Cancel |

™ &ppend

You can create a new file and append an existing text file - that's why you
have an "Append" option. You could for instance add two scanned pages of text
to astudy which you wrote yourself. If you append an existing file, be sureit isn't
currently open, because that will prevent you from writing to it!

Readins

& Unable to write fle 0y Documentsh B eading. itk fle may be in uze by

ather application
Cancel |
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REecoceNIzING MuLTIPLE PAGES

When you click "Save" to save the text, the system prompts you to read an-
other page or not. (If you send the recognized text to a target application or the
clipboard, you obviously won't be prompted to save the text.)

Readiis |

1334 characters in C:\My Documentz\R eadinz. doc

YWwould pou like to szan another page?

MHext Page |

At this stage, some brief statistics are given on the number of characters
you've just read.

You can now open the recognized text with your wordprocessor or text edi-
tor, import it into your desktop publishing software or any other text-based ap-
plication.

But how do you save the text of the additiona pages? Or in other words: how
do you process documents consisting of multiple pages? It's actually very smple:
click "Next Page" when you are prompted to read another page. When you do so,
another page will be scanned promptly if your scanner functions asimage source.
Secondly, the output file and font dictionary are put in the append mode automati-
cally so that you can append the text and continue the font training comfortably.

You can go on recognizing other pages: the new text is appended to the text
file each time you save after the recognition.
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ORGANIZING THE TEXT OUTPUT

Saving or exporting the text means more than selecting an output method or
defining a filename for the output file. You also select a file format and deter-
mine the appearance of the recognized text. In short, you have to decide where
you want to take the text before you launch the execution.

Some options of the "Format" button alow you to influence the look of the
text output.

The text flow of the output document is directly influenced by the option
"Merge Lines into Paragraphs' as you'll find under the "Format" button.

Options
¥ Merge lines inta paragraphs

¥ |nciude graphics

Keep this option enabled to have Readiris detect the paragraphs. Readiris
will then apply the norma wordwrap typical of wordprocessors, otherwise, a
carriage return is added after each line and hyphenated words remain so! Para-
graph detection is enabled by defaullt.

Let's give an example to clear things up. When the firgt three lines of a col-
umn are "The new presi-", "dent waved from the balcony." and "His wife had
joined him.", the paragraph detection gives you the following result: "The new
president waved from the balcony. His wife had joined him." The hyphenated
parts of the word "president” were “reglued” and a space was added at the end of
the first sentence, thus creating naturally flowing text.

Had paragraph detection not been enabled, the origina layout would have
been retained, with a carriage return added at the end of each line.

(The "Format" button contains some formatting options we haven't discussed
yet - thiswill be done shortly.)
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SETTING UP YOUR SCANNER

Let's set our scanner up now. It is assumed that the scanner hardware and
necessary drivers are installed correctly.

If your Readiris software licence was bundled with a scanner model, this step
probably is unnecessary as your scanner may already be set up under Readiris.

Click the "Scanner" button on the main toolbar.

o

Scanner

Click the button "Scanner Modd" to determine your scanner model.

Scanner

Twpe
/H Format; L

Tweain Flathed I l
Ad hd Config... |

Scanner Model. . |

Cancel

Resaolution:
Contrast 0 N Lendecape

ISEIEI :‘v ™ AutoExposure

127 I~ ADE
™ Inwert

o S

Brightness

S

darken lighten

When you select the option "'<Image>" as* scanner”, prescanned images func-
tion asimage source at all times - you won't have even to select the disk asimage
source with the "Source" button on the main toolbar.

The "Config." button is only available when you scanner dlows it. It gives
access to some advanced scanning parameters; with Twain scanners, clicking



&

the "Config." button allows you to select the Twain source. (You can aso use the
command "Select Source" under the "File" menu.)

Select Source E

Sources:

DeskScan 11 2.3
HP PictureScan
HP PictureScan 2.0

Cancel |

Your scanner may also come with a scanning platform such as Visioneer
PaperPort or HP Document Assistant. Depending on the software bundle you
acquired, you may find specialized manuas concerning the scanning platforms
on the Readiris CD-ROM.

Once the scanner is selected, the same window may alow you to set the
scanning resol ution, the page format and orientation, brightness and contrast and
may dlow you to indicate whether you are going to use the scanner's document
feeder. With Twain compliant scanners, al scanning parameters are often set
within the Twain interface.

Select a resolution of 300 dpi for normal applications, use a higher resolu-
tion of 400 dpi for small print (below 10 point) and when the document is very
degraded.

Readiris reads point sizes of 6 to 72 point (0.08 to 1" or 0.21 to 2.54 cm).
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6 point

72 point

Readiris also recognizes “drop letters”, large caps that cover several lines.
(These can of course be no bigger than 72 point!)

eadiris reads drop
letters (also called
“drop” caps) that

cover several lines and
assigns them to their starting
line.

By enabling the option "Landscape”, you indicate that the selected page ori-
entation is wide (“landscape’) instead of tall (“portrait”). The page orientation
actually applies to reduced page formats. on an A4 flatbed scanner, you can
scan, say, A5 pages (half that big) in portrait or landscape format, but you can
obvioudly only scan the full A4 surface in one direction!

=

Whenever you need to adjust the page orientation, you can use the rotation
tools on theimagetoolbar. (Corresponding commands are found under the "View"
menu.)




Fotate Right k

Turn Upzide Diown

[ |

Threerotation directions are available: to theleft, to the right and upside down.
Rotation takes a few seconds as the image itself is updated, not just the display
on-screen.

Set the brightness, and, if available, the contrast. The contrast setting is
only available on some scanners. Drag the trackbar to darken or brighten the
document; the selected values are represented numericaly.

Finaly, the option "Invert" alows you to generate “inverted” images - acti-
vate this option to process full pages with white text on a black background.

SAVING DEFAULT SETTINGS

Set all scanning parameters correctly and click the command " Save Default
Settings' under the "File" menu to save the current settings as default settings
for future use.

Save Default Settings

Settings files contain more than the scanner settings: they also determine
whether you are going to use interactive learning, which font dictionary is used
(and its mode), which language and font type - for instance a normal, propor-
tional font - the documents have, which output mode and layout options are used
- for instance body text sent to WordPad - etc. In short, all operational settings of
Readiris are stored in the settings files.
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SAVING SPECIFIC SETTINGS

The default settings will obvioudly be used at each startup, but you can save
specific settings as well to avoid having to redefine the operational parameters.
The commands "Save Settings' and "Load Settings' under the "File" menu take
care of this.

Load Seftings...
Save Settings... k
Save Default Settingz

Let’'sgive an example: if you regularly have to OCR English documents with
a specific layout, you are recommended to create a settings file for this type of
document. You would then select "English”" as the document language, load a
specific zoning template to avoid having to reapply the same windowing each
time, disable learning but activate a font dictionary in the “read” mode because
the same typefaces are used systematicaly etc.

If you are unsure what the current settings are, you don’t have to “plunge”
into every menu and command to discover what they are. You can use the com-
mand "Info" from the "File" menu to get an overview.



Information on settings |

~Scanner—————————————
Madel Twain Flatbed . Ok
Resolution 300 dpi

Format & Text

Brightriess 127 Foarrnat Rich Text Format
Contrast 127 Paragraph Of

Lapaout Recreate zource

Landzcape gt document
—Document

Font Type Mormal Language Englizh

LetTinG THE OCR WizarD WORK FOR YouU

Now that our scanner is set up, we want to get started capturing documents.
Instead of going through all the parameters, we'll use the OCR wizard, a very
comfortable way of recognizing pages.

Click the "OCR Wizard" button on the main toolbar (or select the command
"OCR Wizard" under the "Process’ menu).

OCR ‘wizard..

COCR Wizard -

Chrl+&

The wizard guides you through the OCR process comfortably: answer afew
simple questions and you'll obtain quick and easy results with Readiris,
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DCR Wizard E3

The DCR wizard leads you through the OCR process
comfortably,

Juzt anzwer these questions and you'll get quick results with
Readiris.

Click Mext to begin,

[+ Enable Wizard on Startup

< Back

Note that the OCR wizard starts running each time you start up Readiris; you
can avoid this by disabling the option "Enable Wizard on Startup" in the first
screen of the wizard (and with the equivalent option under the " Settings' menu).

REcoGNIZING PAGES AUTOMATICALLY

The OCR wizard is a semi-automatic way of recognizing pages. Readiris also
alows fully automatic recognition: instead of being taken through the param-
eters step by step, we will now recognize a page immediately, without any inter-
ruption.

To replace the "OCR Wizard" button on the main toolbar by the "Auto" but-
ton, disable the option "Enable Wizard on Toolbar" under the "Settings' menu.

v Enable ‘Wizard on Toolbar
Auto
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Select the scanner as image source with the " Source” button and click on the
"Auto" button (or select the command "Automatic OCR" under the "Process'
menu).

.

Source

Automatic OCR means that a page is successively scanned, windowed by
page analysis or a zoning template and recognized without interactive learning.
All you have to do is initiate the scanning and save the recognized text, the
intermediate steps are handled by Readiris.

REeADIRIS RECREATES YOUR DocUMENT LAYouT

Automatic recognition, which renders the recognition process automatic,
should not be confused with autoformatting! “Autoformatting” means that
Readiris recreates a facsimile copy of the scanned document: the word, para-
graph and page formatting of your original document are applied.

Similar typefaces (serif and sans serif, proportional and fixed, normal and
condensed) are used as in the source document, the point sizes and typestyles
(bold, italic and underlined) are maintained across the recognition. The tabs and
the dignment (left, centered, right and justified) of each text block are recreated.
The placement of columns, text blocks and graphics follows your original docu-
ment.

In other words, Readiris alows you to archive atrue copy of your documents,
be it a editable and compact text file instead of a scanned image!

All this implies that the sorting of windows only partially applies when
“autoformatting” is used: you can include and exclude zones, but any re-order-
ing of zones is smply ignored!

Here's an example of how it works. To get acquainted with this feature, open
the image AUTOFORM.TIF which is found in your Readiris folder.
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£ Readiriz - D:\Readiris\autoform. tif
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%
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Click the "Format" button on the main toolbar and choose to send the OCR
result to Microsoft Word or sdect the RTF (Rich Text Format) or Word (DOC)
format. Secondly, select "Recreate Source Document” as layout option. (The
option "Merge Lines into Paragraphs’ is enabled by default to apply wordwrap
within the paragraphs.)



Lapout
' Create body test

" Retain word and paragraph farmatting

" Recreate source document

Notethat layout reconstruction islimited to the Word (DOC) and RTF format,
and to documents sent directly to Microsoft Word 97. On the plus side, the Word
(DOC) and RTF formats are widdly used text formats that can be opened by any
popular wordprocessor.

Other, “poor” formats generating “plain” text such as ASCII, ANSI etc. do
not support advanced formatting codes and therefore cannot offer autoformat-
ting. Similarly, the target application WordPad is a “reduced” text editor, not a
fully featured wordprocessor; WordPad may open RTF files but ignores most
formatting codes such as text frames, alignment etc.

When the recognized text is opened using a wordprocessor, the text looks
like this without any intervention by the user.
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19 [=1 E3

W Microsoft Word

@E\Ie Edit Wiew Imsert Format Tools Table ‘window Help

NETEY]

DEHERY i 2ndo o |8 &(H3 W& o 2|2
Mormal v TimesMewRoman = 11 =/ B I 0O HEE_ EvivAv

[v]

Autoformatting

The aim of " autoformatting™ is to recreate a facsimile copy of the original document.

he OCR process does tote than just recognize
I wout text, it can forsmat it for you tool

In a way, text recognition is becoming mote

anid more page recognition or document recognition. .

The wvarious levels of formatting
are: creating body text, retaining
the word and paragraph formatting
and creating a facsimile copy.

Creating body text means no
formatting is applied: you get

a continuous, running text. All -
formatting, if any, is done 2
Whether Readiris reformats the recognized afterwards by the user. @
text or not 15 up to the user. You can perform OCR hi
EEE | »
Sec | 11 |»¢\t Ln Col REE [T EST 2R R /ﬂ

To see the effect correctly, you need to enable the “WY SIWIG” mode of
your wordprocessor, mostly called “page layout” mode. However, if you send the
recognized document directly to Microsoft Word, the “ page layout” view is acti-
vated automatically!

47 Micresoft Word - Document

'@Eile Edit | Wiew Inzert Format  Tools

0| =ld|

Mormal <

Dutline

o [Nomal mﬁw
,: Master Document
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In short, Readiris not only recognizes your texts, but can format them for you
aswell. OCR isn't just text recognition anymore, it is becoming more and more
page or document recognition aswell!

TeEXT FORMATTING, PART 2

The other layout options are " Create Body Text" and "Retain Word and Para-
graph Formatting".

Astheicon on the right side illustrates, creating body text means you create
a non-formatted, “running” text. The text will be captured, but its formatting is
entirely ignored. Use this option when you just need to recapture a text but not
its layout.

" Betain word and paragraph formatting

' Recreate zource document

(Generating Asian text implies creating body text - you cannot apply
“autoformatting” or retain the word and paragraph formatting. Secondly, the
number of file formats is reduced.)

The option "Retain Word and Paragraph Formatting” represents the middle
road: the word formatting - font type (serif - sans serif, proportional - fixed,
normal - condensed), point size and typestyle (bold, italic and underlined) - is
retained across the recognition, and so is the paragraph formatting - the tabs
and the dignment (left, centered, right and justified).
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Lavout
" Create bady text

{* Hetain word and paragraph farmatting

' Recreate source document

Don't confusethisformatting option with “full” autoformatting: this option just
puts one paragraph after the other, it does not recreate columns or copy the
relative position of the various zones. Nor will it include the graphics as full
autoformatting can do.

SAVING GRAPHICS SEPARATELY

In our example, the graphic was included in the recognized text; whether this
is the case depends on the formatting option "Include Graphics'. Saving graph-
ics inside the text is only possible with “full” autoformatting -, not with “poor”
text formats such as ASCII, ANSI etc.

Options
¥ Merge lines inta paragraphs

¥ Include qraphics

Still, with Readiris, you can save graphics without performing text recogni-
tion. As the OCR software Readiris generates black-and-white images, no
greyscale or color images, it doesn't make any sense to scan photographs with
Readiris, but you can capture lineart graphics effortlessly.

How? Draw a graphic zone around the illustrations, cartoons etc. you need.
Creating graphic windows manually is done in the same way as drawing text and
table windows, simply sdlect the "Graphic Window" tool now.
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(Similar to the other window types, the tooltip of the graphic window tool tells
you how many graphic windows there are. And you can press the Alt key while
you select awindow to display its type and its coordinates.)

Next, choose the command "Save Graphics' under the "File" menu.

Save Graphics...

You are prompted to specify a filename.

Graphics File EE3
Save in: Ia My Documents j | gl B =

File name: I Save

Save as hupe: ITIFF 1d PackBitz [*.tif] j Cancel |

TIFF Uncompreszed [*4f)
Zeoft Paintbruzh [*.pox)
TIFF Group 1Y [*.tif]

Determine which graphic file format you will use. Select aformat that's sup-
ported by your paint or photo retouching software. The TIFF and Paintbrush
(PCX) formats are available. (Paintbrush files can aways be opened with the
Windows accessory Paint.)
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The graphics are saved in a single file. You don't have to limit yoursdlf to a
single graphic, but if you draw severa graphic windows, they will be collected,
“gtacked” in a single file. (You can use the "Crop" command of your paint or
photo retouching program to separate them.)

Sides smaller than 1 mm are not alowed - bitmaps of that size hardly contain
any information. “Irregular”, non-rectangular windows are invisibly converted
into rectangles. Readiris covers the maximal surface based on the largest coordi-
nates. In the example below, the graphic window with the black border is com-
pleted by the shaded area.
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mt is read by vour scanner. This device acts as the “eye” of yo

REeADING FAXES AND DEFERRED RECOGNITION

Saving images as image files opens another possibility: you can save the full
page and perform deferred OCR on it later on. That's what we did with the
prescanned images of our tutorials.

Simply scan the document and select the command "Save Full Page as Im-
age" under the "Fil€" menu. You'll again be prompted to save the entire page as
TIFF or Paintbrush (PCX) file.

Save Full Page az Image...

You can now select the disk as image source and open the image file with the
"Open" button (or with the corresponding command under the "Process' menu).
(If you use the "Open" command under the "File" menu, you don't even have to
update the image source.)

Readiris opens black-and-white TIFF images (uncompressed, packbits, Group
3 and Group 4 compressed), Paintbrush (PCX) images and Windows bitmaps
(BMP). This capability is particularly useful to convert your faxes into editable
text files!
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If you have any influence over your correspondents, ask them to send faxes
with the “fing’” quality - those faxes have the higher resolution of 200 dpi and
will yield better OCR results.

Don't forget that you can use “drag and drop” to open images. drop an im-
age file from the Windows Explorer onto the image zone of Readiris and it is
promptly opened!

REecoGNIzING TABLES

So far, we've recognized texts and faxes and we've saved graphics. Let's pro-
cess a table now. Take atable of figures and scan it, or open the sample image
TABLE.TIF in your Readiris folder.

Actually, the image TABLE.TIF contains two tables, and that's no coinci-
dence! The page analysis zones them as table windows, and Readiris will recon-
struct them for you by recreating the tables cell by cell in your spreadsheet or by
inserting a table object inside your wordprocessor files.

Let's explore the different solutions, starting with the “gridded” or “framed”
table - it has borders around the cells.



Ele Edit Settings Miew Process Leam Hegister Help

OCR YWizard

Scan

Sort

Recognize

Enulizh

S,

Sourct

Page Lnalysis

Format

£
Scanner

o]

Reading Tables

Readiris recognizes tabular data and recreates them cell by cell in worksheets
or as table objects inside wordprocessor files,

T insert tables as table objects. you must retain the word and parsgraph lormating or reereate the
source document: see the “Format™ butlon om the muin Loalhar,

I'he page analysis detcels gridded” and “ungridded” tahles. “Gridded” or “framed™ tables have
horders around the cells - ax docs the cxample below. The borders of the table cells gat recreated.

“Mlagridded” tables don’t have any borders around the cells. When the colunms of ungridded
tables are too widely spaced. the page analysis may not dereet a dable window o avold confumiom
with coluninized rext blocks,

Whon your lubles cxclusively contains numeric characters, enable the muneric reading mode with
the "Language™ button on the main toolbar for increased accuracy.

K1

|~

Run the recognition with the layout option "Retain Word and Paragraph For-
matting" or "Recreate Source Document” enabled and the table gets recreated.
Open your wordprocessor to have alook at the result. (You could obvioudy have
included the text paragraphs in the text file as well.)
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W File Edt View Insat Fomet Toos Table Window Help NEET
0| 2la| slRly| & m@lc] o[- 2o Bl [ =0

| [Nomal =l [Tivesnewroman =] [ =] B|Z|u|2l|[E =|=|=] EE=|EE

|¥;S Tip af the Diay: To hyphenate a document as you type, click Hyphenation on the Took menu ﬁ' g”

[ Cim = |

CD-ROM Average ancess CPU Video clip Sequential

CD-ROM 4z speed 442 4.2 TG 612

CD-ROM 12x speed 137 20.9 5 0 4 1,586

CD-ROM 24x speed 80 58.2 30z 2,258

CD-ROM 32x speed 60 72.1 - - 2,987

DVD 58 75.9 = 1 = 3,143

Tested on 333 MHz Pentum II PC with 64 MB RAM and 4 GB SCSIHD :
EEE | ﬂJ
[Page 1 Seci 14| [Ar8S5em Ln 13 Col1 | [FEE [kEK|[E<T (mE [wrr [ A

Now the “ungridded” example - it has no borders around the cells. Note that
the page analysis nevertheless detects the table!
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Whon your lables cxclusively contains numeric characters, enable the nmuneric reading mode with
the “lLanguage™ button ¢n the main toolbar for increascd accuracy.
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Source ‘Hl

Page Analysis
%B
Learm Finally. you car send your tables of figures diteetly 1o Microsell Bxeel by sclecting Lhe spreadshest
E as target application - refer to the “Formut” bulton on the muin toolbar.

Format

§ 1994 Convrish Tmare Recosnilion [ntesrated Svstems
ok

=E =)

Scannst

For optimal OCR accuracy, you should limit recognition to the numeric sym-
bols with the "Language" button. (The numeric mode is not strictly numeric, it
includesthe symbols0to 9, +, *, /, %, , (comma), . (dot), (,), -, =, $and £.)

Mumeric

As you can only do this when the table doesn't contain any aphabetic sym-
bols - otherwise the text portions won't be recognized correctly - we can activate
the numeric mode now but couldn't do it for the first table.

This time, we will send the OCR result directly to the spreadsheet Microsoft
Excel, so we sdlect Excel as target application under the "Format" button.
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Cutput

& Send to Microzoft Whard 97 j
ri ft word 57

€ Edemalie IR
wéhordPad

Layout Clipboard

™ Crazka kedn bk Clipboard E xcel

The spreadsheet is started up automatically and the result looks like this: the
typical table structure with rows and columns is recreated, and you are immedi-
ately ready to process the data.

X Microsoft Excel - Book Mi=] B

ﬁﬁile Edit Wiew Insert Farmat Tools Data Window Help ;[il
x|

DR @Ry (iR o o B

[ aril ~w - B Z U -H-A-

Al | =| 123985

1

2

3

4

5

6

7 -

I4|4» ¥ Sheetl 0 L”J

[ Bum=2578.517 L | B

Also note that you can aso send tables to the clipboard - hence the option
"Send to Clipboard Excd" - and save them in an externa file - hence the file
format Excel (CSV stands for “comma delimited” data).

You may come across “ungridded” tables the page analysis does not detect as
table zones because the columns are too widely spaced - Readiris tries to avoid
confusion with columnized text blocks. To create a table window manualy, click
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on the"Table Window" tool in theimagetoolbar and proceed as usual ; the button's
tooltip again indicates the number of table windows.

| Draw table window: 0]

THE “CoNNECT” FEATURE, ANOTHER DIRECT LINK

Actually, there's yet another way of recognizing tables of figures: you can do
it from within your spreadsheet!

Similar to the "Send to" feature, which exports the reading result automati-
caly, the “Connect” feature offers a direct OCR link between your scanner and
your Windows applications. The only difference is the “inverse” way of pro-
ceeding: you don't recognize your documents inside Readiris to export the result
to a“target” application, Readiris is called up from within your application!

Asthere are some manual steps no installation procedure can take care of for
you, you need to check the on-line help system or the file CONNREAD.DOC in
your Readiris folder to learn how to ingtal it - it takes a macro to use the “ Con-
nect” capability from within Word, Excd and WordPerfect. (That “Read M¢e”
file is displayed automaticaly at the end of the installation program.)
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2 Readiris [_ (O] x]
File Edit Bookmark Option: Help

Help Iop\csl Back | FErint | e | s |

Installing the Connect Capability ii

Preliminary step

Start Readins, select your scanner and save the default settings.

Word 97 (Office 97)
o Start Word. Open the document cowwrper poT.
* Create anew file.

The command Scan Text 15 added to the File menu.

Word2.0to 95

* Start Word. Open the document comveet poc in the Reading folder for Word 2.0 and Word 6.0, or open the
document covveets poc for Word 7.0 (Office 35).

o Answer the questions posed by the system. Answer yes when you are asked to save the global command
changes.

e Create a new file

The command Scan Text 15 added to the File menu.

Excel 97 {Office 97)

Start Excel Cpen the document cower3ws in the Readiris folder. =l

When correctly installed, the “Connect” feature adds a new command to the
menus of your application. In the examples below, the command "Scan Text" is
added to the "File" menu of Word, and the menu "Scan Tabl€e" is added to the
menu bar of Excdl.



X Microsoft Excel - Book _ (O] x|

”ﬁ File Edit %ew Insert Format Tools Data Window Help | Scan Tahble. .. |

NI Edit “iew Insert Fomat  Took
T New. Chl+N
Open... Crl+0
Open UAL...

Browse Weh

Close

Save Ctrl+S
Save hs..

Save 4l

Create Adobe PDF...

el = = le 1o

Properties
Templates...

Page Setup...
Print Prexview
Frint... Chil+P

Send...
Add Bouting Slip...
Past to Exchange Folder...

E it

Scan Text

Here'show it works: Readiris may not run in the background when you launch
the “Connect” macro. Click on the new command in your application menu to
run Readiris. The* Connect” interface may ask you some questions before Readiris
will start running. Proceed as usual and quit the “Connect” interface when you
are through. The recognition results are inserted at the current cursor position.
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GETTING ON-LINE HELP

This concludes our overview of Readiris. Some last-minute information may
not be included in this manual. We thus recommend you to consult the on-line
help system for additional information on Readiris.

Go to the "Help" menu to do so. The command "Help Topics' and its shortcut
key F1 alow you to navigate through the many help topics.

Help Topics: Readiris EHE

Contents | Index | Find |

Click. & book, and then click Open. Or click another tab, such az Index.

'\
@ Recognizing Documents
@ Howa to,,. 7

@ The Connect Capability
@ Reference Infarmation
@ Software Option

@ Froduct B eqgistration
@ Product Suppart

@ RS

Open I Print... Cancel
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